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Should you encour ter problems with this game, either technical
| or concerning gameplay, then you can reach us by telephone,

fax or email. For technical quenes, please have your computer’s

specification (amount of RAM, processor type, etc.) to hand.
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INSTALLATION
installation sous Windows
Insérez le CD-ROM Wetrix dans le lecteur de CD de votre PC.

Exécutez le programme SETUP.EXE qui se trouve dans le répertoire
principal du CD-ROM Wetrix, accessible en cliquant deux fois sur
licone du CD-ROM, dans la fenétre Poste de travail.

Vous étes alors invité a indiquer le dossier dans lequel vous
souhaitez installer Wetrix ; un dossier par défaut vous est
proposé. Le programme d'installation installe Wetrix sur votre PC
et crée un raccourci Wetrix sur votre bureau ainsi que dans le
menu Déemarrer.

Pour jouer a Wetrix, il vous suffit de cliquer sur ce raccourci.
Vous pouvez également sélectionner Wetrix dans le menu
Démarrer / Programmes / Wetrix.

Pour que Wetrix fonctionne correctement, il nécessaire d'installer
DirectX 5.0 (ou une version ultérieure). Pour installer DirectX5.0,
exécutez le fichier DXSENG.EXE qui se trouve dans le dossier Wetrix.

Déolnstallatlon sous Windows

dé staller Wetrix, sélectionnez Iopt:on Parametres, puis

ion Panneau de configuration dans le menu Démarrer. Cliquez
deux fOI"Sl.H’ Ticéne Ajout/Suppression de programmes. En
principe, Wetrix apparait a la fin des programmes énumérés dans
’'onglet Installation/Désinstallation. Sélectionnez Wetrix for
Windows 95, puis cliquez sur le bouton Ajouter/Supprimer. Wetrix
sera alors automatiquement deésinstallé.

Sontiguration matérielle requise

ium (microprocesseur P200 ou plus puissant recommandé
Juer sur un écran de haute résolution)
946 Mo de RAM =
5 Mo d'espace disque pour une installation compléte
(18 Mo pour une installation monolingue)

.::" 95 (ou version ultérieure)
E AEANDONWARE
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DEMARRAGE
Lancer Wetrix pour Windows

Pour démarrer Wetrix sous Windows, cliquez deux fois sur le
raccourci WetrixDEF_ SHORTCUT situé sur votre bureau ou bien
sélectionnez Wetrix dans le menu Démarrer / Programmes / Wetrix.

Si aucun de ces deux raccourcis n'existe, ouvrez I'Explorateur
windows et recherchez le fichier WETRIX.EXE dans le dossier
Wetrix. Pour démarrer Wetrix, cliquez deux fois sur ce fichier.

Configuration du programme sous Windows

La barre de menus située en haut de la fenétre Wetrix permet
d’'accéder aux options de configuration du programme. En mode plein
écran, vous devrez d’abord appuyez sur la touche ALT, puis sur la
touche FLECHE BAS pour accéder a ces menus. Pour passer d’ un
menu a l'autre, utilisez les touches ﬂechees ou la souris.

Menu « Game » (Jeu)

Le menu Jeu compte une option, Quitter, qui permet de quitter
le programme.

Menu « View » (Affichage)

Le menu « View » (Affichage) permet de cm figurer
d'affichage de la fenétre dans laquelle se demule la partie. Deux
jeux d’options sont dlsponlbles s . Wmdowed » (Mode fenétre) et
« Full-screen » (Plein écran) .

Les deux modes fenétre dlspombles sont Fenétre et Plein ecran.
En mode Fenétre, le jeu s'affiche dans une fenétre sit ut.
de votre bureau ; en mode Plein écran, le jeu s'affi

ent de changer la résolution de
3t e lorsque le jeu n'est pas exécuté

en mode Plein écran. Deux ré
* 240 et 640 * 480. En résolution

Iafflchage plus précis, mais .e! , =
qu'avec |a’é résolutton 320 * 240. B
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La Résolution 640 * 480 permet d'obtenir un affichage de basse
résolution (320 * 240) mis a I'échelle pour correspondre a une
fenétre de résolution 640 * 480. Ainsi, la vitesse d'exécution est la
méme qu'avec une basse résolution, mais la fenétre dans laquelle
se déroule la partie est plus grande. En mode Plein écran, cette
option est identique a l'option 320 * 240.

Menu « Help » (Alde)

Le menu « Help » (Aide) vous permet d’accéder au fichier d'aide

et d'obtenir des informations relatives a la version de Wetrix que
vous étes en train d’exécuter. Trois options sont disponibles : «

Contents » (Index), « Find » (Recherche) et « About Wetrix... » A
propos de Wetrix...

L'option « Contents » (Index) vous permet de consulter le
sommalre clu flchlel' d’aide et Ioptlon « Find » (Recherche) de

S

En selectionnant loption « About Wetrix... » (A propos de
Wetrix...) vous obtiendrez des informations relatives a la version
du programme Wetrix que vous avez installée.

MENUS DU JEV

e Wetrix a été chargé, le joueur est invité a sélectionner
puis le menu principal apparait. Ce menu contient un

i ﬁi‘; :'g:;: {.

certain nombre d'options ; il n'est possible d'activer qu'une seule

option  Ia fois. L iion activée apparait en surbrillance.

Pour activer une OptIOI'I differente, il suffit d'utiliser les touches
fléechées vers le haut et vers le bas, puis d'actionner la barre

ace. |l est également possible de placer la souris sur un menu
 puis d’appuyer sur le bouton gauche de la souris pour

Yo tion sélectionnée.

Sl aucune option n’et sélectionnée, le mode
dmonstration (exécuti on en boucle) de Wetrix est
es meilleurs scores apparait.

ivé et le tableau des
r revenir a Iécrarj initlal et au menu principal, il
d’actionner la barre espace ou le bouton
uche de la souris pendant la démonstration.
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Menu principal

Le menu principal apparait la premiére fois que Wetrix est chargé
ou bien lorsqu’'une partie de Wetrix se termine. Ce menu permet
d’accéder a toutes les options de jeu disponibles.

Wetrix classique
Cette option permet de démarrer une partie de Wetrix classique.

Wetrix Pro
Cette option permet de démarrer une partie de Wetrix pro.

Mode entrainement
Cette option permet de démarrer une partie de Wetrix en
mode entrainement.

Modes casse-téte |
Cette option permet d’accéder au menu Modes casse-téte, Ieanel
permet de sélectionner différents types de jeux de casse-téte.

Ecran 2 joueurs
Cette option permet de démarrer une partie sur un écran
deux joueurs.

Cette option permet d'accéder au menu Options, lequel ne t
configurer la manette de différentes facons et
e %i?*
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Le menu Modes casse-téte permet d'accéder aux différents types
de jeux de casse-téte disponibles dans Wetnx. Ces jeux de casse-
téte constituent des variantes du Wetrix class:que varlantes
offrant des obstacles et des handlcaps supplernenta
surmonter pendant la partie.

Modes challenge i
Cette option permet d’accéde m

lequel permet de sélectionner di ‘_' -
mode challenge.

Modes handicap
Cette option permet d’'acc
handicap, lequel permet de sél
types de jeux en mode handi
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Retour
Cette option permet de revenir au menu principal.

Ecran 2 Joueurs

Ecran 2 joueursGP_1v2
Cette option permet de démarrer une partie de Wetrix fup v 2up,
sur un écran 2 joueurs.

Retour
Cette option permet de revenir au menu principal.

COMMANDES DE JEV

Dans Wetrix, le systéme de commande est trés simple : le joueur
agit sur les différentes piéces individuellement, a mesure qu'elles
tombent sur le terrain.

Les commandes de déplacement permettent de déplacer la piéce
alors qu'elle est en train de tomber, le bouton de rotation permettant
de modifier l'orientation de la piéce selon un axe perpendiculaire au
terrain. Le bouton de placement permet d’augmenter la vitesse de la
piéce qui tombe jusqu'a la vitesse maximale.

ton d’attaque permet de lancer l'attaque active contre Ies
' présents en mode multi-joueurs ou de lancer des “
53_;’,, en mode joueur unique.

sma

Les mellleurs scdres sont entrés au moyen des commandes de
jeu plutot qu'a partir du clavier, ce qui permet aux joueurs de
rester en position entre deux jeux et de continuer a utiliser le
‘mode de commande qu'ils--ont sélectionné.

" Options permet de sélectlonner différents modes

5t également poss %_ 9 de jouer a Wetrix a partir du
ier, griace a deux ;._,?E’.f.iguratlons prédéfinies

ettant d exécuter différentes actions énumérées
prés. Les touches utilisées dans chacune de ces

nfigurations peuvent étre redéfinies par l'utilisateur.
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En mode 2 joueurs, les deux joueurs peuvent utiliser le clavier
simultanément en sélectionnant Clavier A pour joueur 1 et Clavier
B pour joueur 2.

En mode joueur unique (modes classique, pro, entrainement et
casse-téte), les touches de chacune des configurations sont
disponibles simultanément.

Clavier A

Il s'agit la de la configuration par défaut du Clavier A. Lorsque le
joueur redéfinit cette configuration, la nouvelle configuration est
enregistrée définitivement.

Les touches L, [virgule], Z & X permettent de déplacer les piéces
selon quatre directions lorsqu’elles tombent.

La barre espace permet de réorienter une piéce lorsqu’elle tombe.
La touche C permet de faire tomber la piéce active plus rapidement.

La touche “ majuscules ” située a gauche du clavier permet de
lancer une attaque en mode multi-joueurs ou de lancer une “
smart bomb ” (s'il y en a) en mode joueur unique.

La touche \ [barre oblique inversée] permet d’activer les différent
adversaires sélectionnés durant une partie en réﬁieau,t lesqu@_f
peuvent alors attaquer. T Al

La touche ESC permet d'interrompre la partie et afflche un menu
offrant la possibilité au joueur de quitter ou de redémarrer la
partie en cours.

Clavier B

Il s’agit 1a de la configuration par défaut du Clavler
joueur redéfinit cette conflguratlon, Ia nouvelle co
enregistrée definitivement. A -

Les touches fléchées permett de déplacer chaque plece
qui tombe. :




La touche + du clavier numérique permet de lancer une attaque en
mode multi-joueurs ou de lancer une “ smart bomb ” (s'il y en a)
en mode joueur unique.

La touche [enter] du clavier numérique permet d’activer les
difféerents adversaires sélectionnés durant une partie en
réseau, lesquels peuvent alors attaquer.

La touche ESC permet d’interrompre la partie et affiche un menu
offrant la possibilité au joueur de quitter ou de redémarrer la
partie en cours

Souris

La souris peut étre utilisée en mode joueur unique, mais aussi
pour commander l'un des deux camps en mode 2 joueurs.

"*I::ﬁrsque la souris est utilisée, un fondu apparait au-dessus de I'ombre
de la plécé qui est en traln de tomber. Il correspond au mouvement
décrit par cette “ ombre " que le joueur déplace en utilisant la
souris. L'ombre peut étre déplacée de maniére quelconque au-dessus
du terrain, aussi vite que la souris le permet, mais la piéce réelle se
déplace a la vitesse réglée et essaie de rattraper 'ombre en train de
tomber. Ainsi, le joueur utilisant la souris n'est pas avantagé par

ort aux autres puisque la souris ne permet pas de déplacer la
réelle plus vite que la normale.

_ ;dmit de la souris correspond au bouton de rotation et
le bouton gaucha, au bout de placement. Pour lancer une attaque
en mode rnultl-loueu:§ ou une “ smart bomb ” en mode joueur
unique, il convient d.uglgiggr le clavier.

t un jeu de casse-téte se déroulant sur un terrain carré et

ko

ique. Le joueur agit sur des pleces de dlfferentes formes

in, elle est recupég_;.i‘”'_gf
_an. Dés que le fosj_"f;,; est plein, la partie est terminée.
rincipe est sumple maus les types de piéces et

ettant de gerer les différents types de jeu et les
W_Ombreux trucs et astuces a découvrir sont nombreux !
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Régles du jeu

Le joueur a la possibilité d'agir sur chaque piéce qui tombe. Le cas
échéant, il peut réorienter une piéce et si une piece est orientée
correctement avant d’atteindre le terrain, il peut appuyer sur le
bouton de placement pour gu'elle tombe plus rapidement,
augmentant ainsi le nombre de points acquis et se donnant plus de
temps pour contenir 'eau qui s'écoule.

Au début de chaque partie, les premiéres pieces qui tombent sont
des ‘Uppers’ rouges ; ces piéces élévent le niveau du terrain sur
lequel elles tombent. Le terrain étant toujours plat au départ (sauf
dans certains modes handicap), toute eau qui tombe se dirige
automatiquement vers le bord du terrain et s’écoule dans le fossé.
Dans un premier temps, le joueur devra donc s’efforcer d'utiliser les
‘Uppers’ pour créer des enclos destinés a réceptionner I'eau qui
tombe. Le joueur peut créer un ou deux enclos de petite taille ou
bien essayer de construire un mur unique, correspondant au
périmétre de 'ensemble du terrain.

Peu a peu, différents types de piéces commencent a tomber.
L'indicateur “ Prochaine piéce ” situé en bas a droite de I'écran
affiche le prochain type de piéce attendu, sans en indiquer sa
forme. Cette derniére n'est révélée qu'au moment ou la piéce en
question apparait.

Dés que les bulles d'eau commencent a tomber.x ueL
positionner de maniére a ce qu'elles atterrissent dans |

a créeés, quel que soit leur type ; ainsi, lorsque l'eau sortira de
chacune des bulles, elle sera retenue dans les enclos de maniere
siire. L'eau des lacs tente toujours de s’écouler vers le point le plus
bas : en conséquence, lorsque le mur présente des bréches, I'eau
s’écoule en dehors de I'enclos, vers le bord. Tout comme les

ggggg

Si le joueur décide de creer d abord de petits enclos, il devra prévoir
la construction d'un mur autour adg;;terram suffisamment tot pour

' place un certain n

_r verts pour aba




Peu aprés, les bombes et les boules de feu commencent a tomber.

Le joueur peut évaporer I'eau et baisser le fossé en lancant une
boule de feu au centre d'un lac profond. Sous I'action de la boule
de feu, I'eau s’évapore jusqu'a ce que le fond soit atteint ; a ce
moment-Ia, la boule de feu s’éteint. Veillez a ne pas lancer de
boules de feu sur un terrain sec ; elles exploseraient et
endommageraient le terrain.

Les bombes sont plus difficiles a maitriser dans la mesure ou, quel
que soit I'endroit ou elles atterrissent, elles explosent ; non
seulement elles endommagent le terrain, mais elles font aussi des
trous permettant le passage de l'eau. Il convient donc de toujours
les lancer a des endroits autres que des lacs, afin de prévenir toute
fuite d’eau.

_ Les ‘Uppers’ peuvent également étre utilisés pour créer de nouveaux

i "Wés dans des lacs existants ou pour réparer des dommages causés
par des bombes ou des boules de feu. Ne construisez pas trop de
murs, cependant ; le terrain deviendrait instable et présenterait des
risques de tremblement de terre. Le compteur situé a gauche de
I'écran avertit le joueur lorsque cela est sur le point d'arriver. Les
bombes et les boules de feu permettent de détruire rapidement du

terrain, réduisant ainsi le chiffre affiché par le compteur a séismes.

points acquis pendant la partie sont multipliés par le
acs présents dans le monde. Le nombre de lacs est
[cateur de lacs situé en haut a droite de I'écran.

_ | _'.Sl le joueur recuemgf gsuffisamment d'eau, un arc-en-ciel apparait :
- tant que l'arc-en-ciel reste afficheé, tous les points acquis sont
‘un lac suffisamment profond, un canard

multlplles. Si le |oueur cr'_";f"
lasthue apparait ; tant :.ja=:';§;f_;_3;!§-_canard reste sur le lac, tous les

___.?Ms bonus sont nombreuses le
;'”’f*?%&st mscrlt en bas a gauche de

qu ue fois que le mvaau augmente, la couleur du
in change et la vitesse augmente. Les points acquis
gmentent également et selon le type de jeu

ectlonne, différentes fonctions peuvent étre

aaaaaa
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introduites. Le niveau actif est précisé par l'indicateur de niveau
situé en haut a droite de I'écran.

La partie se poursuit jusqu'a ce que le fossé soit plein ou qu'un
objectif soit atteint.

Types de jeu

Wetrix offre différents types de jeu ; il s’agit pour la plupart de
variantes du mode joueur unique, ou I'objectif du joueur consiste
a enregistrer le meilleur score possible, ou de variantes du mode
multi-joueurs, ou I'objectif de chacun des joueurs consiste a
battre tous les autres joueurs de la partie.

Wetrix classique

Wetrix classique correspond a la version joueur unique intégrale
de Wetrix, I'objectif consistant a enregistrer le meilleur score
possible. La partie démarre au niveau le plus bas, avec un terrain
plat, et les premiéres piéces qui tombent sont toujours des
‘Uppers’ qui permettent au joueur de batir un certain nombre de
murs avant que I'eau et d’autres piéces ne commencent a tomber.

Le niveau augmente toutes les deux minutes environ. A ce
moment-13, la couleur du terrain change, la vitesse augmente et __ |
nouvelles fonctions sont parfois introduites. La partie se poursuit
jusqu’au niveau maximum, le niveau 10 ; la partie se joue alors a
la vitesse maximale et toutes les fonctlons sont utilisées.

Il existe différentes facons d'acquérir des points lors d'une partie de
‘Wetrix classique ; certaines tombent sous le sens alors que d’autres
sont plus subtiles. Selon la stratégie adoptée, le nombre de points
acquis différe de beaucoup Avec le temps, le joueur se rendra

niveaux qu'un joueur prudent au cours de toute uné pa B e

En mode Wetrix classique, les &x scores les plus éleves sont
enregistrés dans un tableau rms a jour en permanence.

--------

E
Wetrix pro
R =
e

Wetrix Pro correspond a la veréngn joueur unique e

de Wetnx. La couleur du terrawg de l'arriére-plan est
le méme : il s'agit de

gagner Ie plus de points possil e les obstacles étant
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beaucoup plus difficiles a surmonter. Par défaut, la partie commence
au niveau 5 du mode Wetrix classique, mais le joueur n'a pas la
possibilité de construire aussi facilement et généralement, les parties
ne durent pas longtemps. Dans ce mode, il arrive que des bombes
doubles tombent ; d'autres types de piéce sont également disponibles.

En mode Wetrix Pro, les dix scores les plus élevés sont
enregistrés dans un tableau mis a jour en permanence.

Mode entrainement

Le mode entrainement est une version joueur unique spéciale de
Wetrix qui permet aux débutants de se familiariser avec les
principes de base de Wetrix sans étre importunés par certaines
fonctions complexes. La couleur spécifique du terrain renseigne
sur sa hauteur, les éventuels trous présents dans le sol étant
colorés en rouge vif et les hauteurs du terrain, en vert foncé.

En mode entrainement, les piéces ne tombent qu'a partir du
moment ou le joueur utilise le bouton de placement ; il dispose
ainsi de tout le temps nécessaire pour orienter les piéces.

Modes casse-téte

Les modes casse-téte correspondent a des versions joueur

particuliérement complexes.

Il existe deux types de modes casse-téte : les modes challenges
et les modes handicap.

,,,,,

chiffres vont en décroissant a mesure que la
artie progresse.
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Les modes challenge permettent aux joueurs de comparer leurs
compétences lorsqu’ils jouent a Wetrix seuls puisqu'ils peuvent |
définir un nombre de piéces ou un délai identique, et obtenir ainsi |
des scores comparables.

Pour chaque mode challenge, le score le plus élevé est enregistré
et mis a jour en permanence.

Modes handicap

Les modes handicap correspondent a des versions joueur unique
de Wetrix : le joueur doit faire face a une difficulté
supplémentaire dés le début de la partie.

Les modes handicap permettent aux joueurs experts de tester
leurs compétences, d’obtenir des scores élevés et de surmonter
des handicaps difficiles.

SR

§ TR T
i

Pour chaque mode handicap, le score Ie plus élevé est
enregistré et mis a jour en permanence.

Mode 2 joueurs

Dans Wetrix, le mode 2 joueurs obéit aux mémes régles de base
que le mode joueur unique, mais il offre la possibilité de lancer
des attaques supplémentaires contre des adversalras; Aucuﬁ
n'est acquis durant la partie ; le score corre;f"""’

nombre de parties multi-joueurs que chaque 1aueur a gagnées.

Généralement, les parties multi-joueurs sont plus courtes et plus
rapides, le but étant pour vous de jouer contre vos adversaires
autant de fois que possible plutét que de rester en vie le plus
longtemps possible. :

Le mode 2 joueurs correspond a une version cle
Wetrix, 'écran étant divisé en deux parties. Tout e nt sa
propre partie de Wetrix, chacun des joueurs peut attaquer Iautre
en ayant recours a différents types de piéces ou d'effets. Le |
“%wpremler perd la partle, Pautre |

joueur dont le fossé est plein
joueur en étant le valnqueur._\_f_if‘}-if“ 1
durant la partie ; seul le nombre
par chacun des joueurs est en ;fgistré.




Dans ce mode, la partie inférieure de chacune de deux zones de
jeu affiche une barre d’énergie, ainsi que quatre icones
correspondant aux quatre sections de la barre d’énergie et
représentant 'eau, la glace, les tremblements et les bombes.
Contrairement aux parties a joueur unique, 'eau évaporée ne
contribue pas a réduire la quantité d’eau présente dans le fossé du
joueur, mais plutot & augmenter la quantité d’énergie disponible
dans la barre d’énergie du joueur. A mesure que cette quantité
d’énergie augmente, différentes icones s'illuminent dans la barre
d’énergie ; a tout moment dans la partie, le joueur peut utiliser
toute son énergie pour lancer une attaque contre l'autre joueur, en
fonction de licone illuminée active. Il pleuvra alors de l'eau, de la
glace ou des bombes ou bien un tremblement de terre sera
déclenché sur le terrain de l'autre joueur.

Pour chacune des quatre sections de la barre d’énergie, plus le
curseur se déplace vers la droite, plus la puissance du type
d’'attaque correspondant est importante. Par exemple, si le curseur
se trouve a gauche de la section verte de la barre d’énergie et
que l'un des joueurs attaque, une attaque de glace faible est
lancée. Si le curseur se trouve au milieu de la section verte, une
attaque de glace moyenne est lancée, et si le curseur se trouve a
droite de la section verte, une attaque de glace forte est lancée.
Plus licone illuminée située au-dessus du curseur est grande, plus
I'attaque est puissante.

que spéciale permet également de voler de I'énergie
e d'énergie de I'adversaire...

dans la

AIDE COMPLEMENTAIRE

Plus vous découvrirez de stratégies en jouant a Wetrix et plus vous

jue le jeu. Pour effectuer des recherches dans ce fichier,
ns le menu AIDE, en haut de la fenétre Wetrix.
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urriez rencontrer dans le jeu
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